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 UVOD 

U ovom je radu opisano istraživanje i modeliranje rezervi arhitektonsko građevnog 

kamena na istražnom prostoru Aržano. 

Glavni razlog zašto se uopće krenulo sa idejom dva površinska kopa u mjestu Aržano je 

blokovitost stijena koja je uočljiva na površini a u geološkom tumaču su prisutne geološke 

formacije opisane tako da se upućuje na perspektivnost arhitektonsko-građevnog kamena. 

Dokazi su mnogobrojne građevine (kuće, štale, dalmatinske „kužine“, itd.) koje su davno 

izgrađene od postojećeg kamena. Ljudi su pronalazili stijene ispod površine zemlje, tj. kopali 

su kamen ručno i nalazili vrlo kvalitetan kamen koji je bio pogodan za građenje. 

Kamen se obrađivao ručno (tucao se čekićem i dlijetom), pa je to bio jako težak, spor i 

mukotrpan posao, ali nastali objekti su i danas atrakcija iako su stari preko 100 godina. 

Primjer kuće izgrađene takvim kamenom vidi se na slici 1-1. 

  

Slika 1-1. Kamena kuća iz mjesta Aržano 
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 OPĆENITO O LEŽIŠTU ARHITEKTONSKO-GRAĐEVNOG KAMENA U 

PODRUČJU ARŽANO 

2.1. Zemljopisni položaj 

Područje Aržano se nalazi u Dalmatinskoj zagori na samoj granici sa Bosnom i 

Hercegovinom na 23 km sjeverozapadno od Imotskog. Prometna veza je ostvarena 

državnom cestom D39 koja povezuje Aržano sa morem i Bosnom i Hercegovinom. 

Planirani istražni prostori „Aržano sjever“ i „Aržano jug“ prikazani su na slici 2-1. 

 

Slika 2-1. Topografska karta istražnog prostora „Aržano sjever“ i „Aržano jug“ 1:25 000 
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Koordinate vršnih točaka i površine istražnih prostora „Aržano sjever“ i „Aržano jug“ 

prikazane su u tablicama 2-1. i 2-2. 

 

Tablica 2-1. Koordinate vršnih točaka planiranog istražnog prostora „Aržano sjever“ 

Oznaka 

vršne točke 

Koordinate vršnih točaka planiranog istražnog prostora HTRS96 / TM 

Y X Z 

I 4828438 535764 627 

II 4828595 537791 581 

III 4829129 537864 353 

IV 4829340 535967 198 

Površina 

istražnog 

prostora 

140,65 ha 

 

 

Tablica 2-2. Koordinate vršnih točaka planiranog istražnog prostora „Aržano jug“ 

Oznaka 

vršne točke 

Koordinate vršnih točaka planiranog istražnog prostora HTRS96 / TM 

Y X Z 

V 4827602 536078 014 

VI 4827542 537735 562 

VII 4828441 537818 611 

VIII 4828321 536115 912 

Površina 

istražnog 

prostora 

135,82 ha 
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2.2. Geologija područja 

Na slici 2-2. prikazana je Osnovna geološka karta SFRJ 1:100 000, list Omiš s 

prijedlogom istražnih prostora „Aržano sjever“ i „Aržano jug“, a na slici 2-3. je legenda 

karte.  

 

 

Slika 2-2. Osnovna geološka karta SFRJ 1:100 000, list Omiš, uvećano na M 1:50 000 

(Marinčić i dr., 1969). 
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Vapnenci s lećama 

dolomita- kimeridž, 

portland 
 

Pad rasjedne plohe i relativno 

spušten blok 

 

Dobro uslojeni 

kalcilutiti i kalkareniti 

 

Čelo navlake: utvrđeno i 

pokriveno ili nesigurno 

locirano 

 

Normalna granica: 

utvrđena (s padom) i 

aproksimativno 

locirana (s padom) 
 

Trase slojevitosti, fotogeološki 

utvrđene 

 

Elementi pada sloja: 

normalan i prevrnut  
Izobata 10 m 

 

Rasjed bez oznake 

karaktera: utvrđen i 

pokriven ili nesigurno 

lociran: fotogeološki 

utvrđen rasjed 

 
Automobilski put 

 
Slojnica (izohipsa) 50 

m sa padnicama terena 
 

Slatkovodna i marinska 

makrofauna 

 

Slojnica (izohipsa) 

500 m sa padnicama 

terena  

Mikrofauna i mikroflora 

Slika 2-3. Legenda geološke karte (Marinčić i dr., 1969). 

 

2.2.1. Vapnenci s lećama dolomita gornjeg malma (J3
2,3) 

Ove naslage prostorno su najraširenije u juri, a na čitavom su području dokazane brojnim 

nalazima provodnih fosila. Osim velikog broja primjeraka vrste Clypeina jurassica česti su 

još sljedeći oblici: Kurnubia palastiniensis, Favreina salevensis, aberantne tinitinine, 

Bauneina multitabulata, Stenoporidium, Cyclammina, Thaumatoporella parvovesiculifera, 

te školjkaš Mesodiceras sokolovi od makrofosila. 

Prema petrografskim osobinama i ovdje su zastupani slični članovi vapnene serije kao u 

cijeloj juri s tim što su češći oolitični kalkareniti, karakteristični za pojačane lokalne 

turbulencije u zatvorenim dijelovima bazena. Uvjeti su pogodovali i povremenoj 

dolomitizaciji, pa ima svih prelaza između dolomita i vapnenaca. Slojevitost je dobro 

izražena. (Marinčić i dr., 1969). 
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2.2.2. Dobro uslojeni kalcilutiti i kalkareniti (K1) 

Pripadnost ovih naslaga donjoj kredi dokazuju brojni mikroorganizmi. Zajedničke vrste 

za cijelo područje su: Orbitolina cf. Discoidea, Salpingoporella dinarica, Bačinella 

irregularis, Cuneolina pavonia parva i Nummoloculina heimi. U sjevernom predjelu javljaju 

se još sljedeće vrste: Cuneolina camposaurii, Coskinolinoides texanus, Hanlophragmoides 

greigi, Texturlariella, a u južnom Lithocodium aggregatum, Acicularia endoi, Nezzazata 

simplex. Osim citiranih u sjevernom području su u vršnim dijelovima donje krede nađene i 

vrste Pianella turgida i Coskinolina cf. sunnilandensis, koje se obično javljaju u cenomanu. 

Od makrofaune je sakupljeno samo par gastropoda od kojih su specifično determinirane 

dvije vrste: Nerinella cf. Dayi i Nerinella of schicki. 

Prema navedenim vrstama donja kreda lista Omiš pripada rasponu barem-alb. Niži dijelovi 

donje krede nisu faunistički dokazani. U južnom dijelu terena oni su vjerojatno dobrim 

dijelom reducirani, dok su u sjevernom dijelu dokazani superpozicijom. 

Na cijelom listu donja kreda je izgrađena od svijetlosivih do svijetlosmeđih srednje do 

debelo uslojenih, gromadastih a mjestimično i tanko pločastih vapnenaca nepravilnog do 

školjkastog loma. Dolomiti se javljaju u vidu preslojaka i tanjih slojeva. Vapnenci pripadaju 

alohtonom tipu sa svim članovima alohtonog niza. Pretežu kalcilutiti i grumulozni vapnenci, 

dok su kalkareniti i kalciruditi manje zastupljeni. U južnom dijelu se sporadično susreću 

biokalkareniti i biokalciruditi. Dolomita i dolomističnih stijena ima malo. Odgovaraju 

sekundarnom tipu dolomita. Stupanj dolomitizacije je različit, te postoje svi prelazi od 

magnezijskih vapnenaca do čistih dolomita. Postotak CaCO3 u vapnencima obično prelazi 

98%. 

Sedimentacija se odvijala uglavnom u relativno mirnim uvjetima s malim oscilacijama u 

jačini turbulentnih strujanja, što je uvjetovalo izostajanje krupnozrnih ekvivalenata alohtone 

vapnene serije. Povremene promjene temperature vode, pH, koncentracije soli i drugih 

pogodovale su dolomitizaciji. Obzirom na različiti intenzitet dolomitizacije stvaraju se i 

dolomitne stijene nejednakog postotka dolomitne komponente. Debljina donje krede oko 

600 m. (Marinčić i dr., 1969). 
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2.3. Tektonika područja 

Strukturni sklop ovog područja karakterizira visok stupanj tektonske poremećenosti, što 

je rezultat kompleksnih geoloških zbivanja od starijeg mezozoika do danas. 

Prvi značajniji tektonski pokreti koji se mogu utvrditi, izazvali su paleografske promjene 

i doveli anizičke naslage u dužu fazu emerzije koja je trajala čitavo vrijeme ladinika. S 

obzirom da su se ove promjene dogodile u anizičko doba, i pokreti se mogu pripisati 

počecima alpinskog orogenetskog ciklusa, odnosno pfalačkoj fazi. Može se pretpostaviti da 

se ovo prvo mezozojsko izdizanje odrazilo i na kasniji razvoj mezozoika. Ove prve strukture 

utjecale su na evoluciju strukturnih deformacija bazena u toku sedimentacije i dale prednacrt 

kasnijim mezozojskim tektonskim promjenama. 

Pojačanim epirogenetskim pokretima u donjem lijasu počinje relativno mirnija 

sedimentacija jure, koja traje sve do konca malma kada dolazi do obnavljanja tektonskih 

pokreta. 

Ova tektonska faza vjerojatno nije izazvala bitne regionalne promjene. Naime, ne samo 

što otvorene strukture ovog terena pokazuju relativno kratko trajanje izlazne faze, nego i 

pojedina dalja područja (prema današnjoj Kamešnici) ne ukazuju na prekid sedimentacije. 

Međutim, to ne umanjuje mnogo značaj ovih pokreta važnih za daljnji razvoj plikativnih 

deformacija mezozojskog sedimentacijskog prostora. Tako već u ranijim pokretima 

predisponirane strukture Mosora i Biokova, u ovoj tektonskoj fazi poprimaju karakter 

kordiljera, što je imalo utjecaja u paleografskim promjenama tipa sedimentacije. 

Možda su šireg regionalnog značaja bili slični ponovljeni pokreti koncem donje krede 

koji i dalje imaju karakter plikavitih strukturnih deformacija. Boranjem i kontrahiranjem 

mezozojskog sedimentacijskog prostora, potencirali su preduvjete paleogeografske 

diferencijacije facijesa kod kasnijeg taloženja gornjokrednih i tercijarnih naslaga. 

Značajnije strukturne promjene izazvali su tektonski pokreti na prelazu iz krede u tercijar. 

Plikavite strukture doživljavaju maksimalnu evoluciju, pa je mezozojski sedimentacijski 

prostor razbijen nizom manjih kordiljera koje prati sve šire okopnjavanje. 

Nakon transgresije u gornjem paleocenu ka donjem eocenu, dolazi do jakih regionalnih 

tangencijalnih potisaka sa sjeveroistoka, koji vrše sve jaču kompresiju na labilnije područje 

novog tercijarnog sedimentacijskog prostora. To je razdoblje intenzivnih strukturnih 

deformacija kada se maksimalno razvijene plikativne forme sve više komprimiraju, prevrću 

i konačno lome. Ovi su pokreti generirali pojavu donjoeocenskih naslaga, koje nova 

transgresija opet preplavljuje koncem srednjeg eocena. 
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Posljednja značajna faza jakih regionalnih tangencijalnih pokreta bila je između gornjeg 

eocena i donjeg oligocena. U to vrijeme ovaj tip pokreta poprima najšire razmjere i formira 

najviše tipove strukturnih deformacija – ljuske i navlake. Tada su uglavnom formirane sve 

važnije strukturne jedinice, jer nakon pirinejske faze više nije bilo pokreta koji su izazivali 

nova boranja, što nam dokazuju oligocenske i miocenske naslage. Kasnije, neogenski 

tektonski pokreti mogli su prouzrokovati samo radijalna rasjedanja sekundarnog značaja, 

koja nisu bitno uticala na formiranje recentnog strukturnog sklopa. 

Prema karakteru i intenzitetu strukturnih promjena ovog područja, mogu se razlikovati tri 

osnovne tektonske jedinice: 

A – tercijarni sinklinorij 

B – mezozojski borani kompleks 

C – alohton 

2.3.1. Tercijarni sinklinorij 

Ovoj tektonskoj jedinici pripada priobalni pojas do čela ljuske Kozjaka, Mosora i 

Biokova. To odgovara području tercijarnog sedimentacijskog prostora, odnosno 

najlabilnijem dijelu terena u vrijeme kad počinju najjači jednosmjerni tektonski pokreti 

tangencijalnog tipa. Deformacije je još potencirala vrlo heterogena litološka grada ovog 

područja, odnosno velike razlike u plastičnosti i čvrstoći stijenske mase. Potisci su 

pojačavani još i popratnim pojavama glavnih tangencijalnih pokreta, koji su izazvani novim 

usjedanjima i natiskivanjima u bližem zaleđu. 

Bazen je izboran poprimivši karakter sinklinorija s izduženim, stisnutim ešaloniranim 

antiklinalama senonskih vapnenaca okruženih flišom. Bore su izoklinalno polegle, prevrnute 

i redovito ljuskavo raskidane. 

Osnovni tip strukturnih deformacija ove tektonske jedinice je ljuskava građa, gdje su 

prevrnute senonske antiklinale reversno natisnute tektonski reduciranim jugozapadnim 

krilima na eocenski fliš. Zbog velike razlike u litoloskoj građi terena, čela ljuske su redovito 

morfološki dobro istaknuta. 
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2.3.2. Mezozojski borani kompleks 

Ovoj tektonskoj jedinici pripada široko područje zaleđa od čela ljuske Kozjaka, Mosora 

i Biokova, do čela navlake Jabuka - Aržano. To je pretežno litološko kompaktan karbonatni 

kompleks jursko - krednih naslaga s manjim pojavama tercijara. 

Vjerojatno je da su već prvi tektonski pokreti pfalačke faze počeli formirati osnovne bore, 

dok novokimerijskom i austrijskom fazom, a kasnije i laramijskom, ovaj kompleks poprima 

karakter boranog područja pretežno simetričnih struktura. Eocenski tektonski pokreti 

eksponiraju već formirane bore, mjestimično ih prevrću, pa i reversno natiskuju na 

sinklinalne dijelove gornjo-krednih naslaga ili foraminiferske vapnence formirajući tako i 

ljuske. 

Karakteristična je za ovaj kompleks struktura Mosora, koja u vrijeme ovih mladih, 

orijentiranih tangencijalnih pokreta, egzistira kao stabilnija kopnena masa. Zbog tog otpora, 

potiskivane strukture djelomično zaobilaze centralnu Mosorsku strukturu prema područjima 

manjih otpora, mijenjajući smjer svojih osi. Međutim, potisci se prenose i na ovu stabilniju 

masu,  koji se naročito odražavaju na granici prema tercijarnom sedimentacijskom prostoru 

gdje se formira jaka fleksura. Slično se događa i sa strukturom Biokovo. Fleksura se reversno 

natiskuje čelom ljuske na tercijarne sedimente, u potezu od Kučina preko Gata do Basta. 

Markantan element ove tektonske jedinice je manja navlaka lokalnijeg značaja u području 

Dolca i Dugopolja. Nastala je stara jača fleksura formirana vjerojatno još u pfalačkoj fazi. 

Djelomično je navučena donjokrednim i cenomanskim naslagama na fliš Mosorskog zaleđa, 

stvarajući tektonska poluokna, što je i bio glavni razlog tretiranja ove strukturne deformacije 

kao navlake. 

Česti popratni transverzalni i longitudinalni lomovi sekundarnog su značaja, jer nisu imali 

važnijeg udjela u formiranju ove tektonske jedinice. Od ovakvog tretmana odstupa samo 

longitudinalni lom koji je uslijedio nakon glavnih pokreta u ovom terenu, presijecajući 

važnije strukturne forme, pa i navlaku Dolac - Dicmo. Proteže se duž čitavog terena, od 

Konjskog, Klisa, Mosorskog grebena, do sjevernog podnožja Biokova, i cijelom je svojom 

dužinom primjetno spustio naslage u sjevernom krilu. 

Općenito se može reći da ova tektonska jedinica u odnosu na tercijarni sinklinorij, 

egzistira kao antiklinorij. 
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2.3.3. Alohton 

Ovoj bi tektonskoj jedinici pripadalo područje sjeveroistočno od čela navlake, koje 

prelazi u luku od Jabuke i Vrpolja na Aržano. 

Ovdje su primarne deformacije izazvali jaki pfalački pokreti koji boraju anizičke naslage 

i formiraju istaknutu fleksuru, čiji je današnji vidljivi ostatak područje od Jabuke do Vrpolja. 

Kasnijim mezozoičkim pokretima fleksura je došla u fazu ljuske, da bi tokom eocena za 

pojačanih regionalnih tangencijalnih pokreta, evoluirala u navlaku. Navučena je klastičnim 

donjotrijaskim naslagama preko mlađemezozojskih vapnenaca autohtona. Može se 

pretpostaviti da su i mlađepaleozoičke klastične naslage zahvaćene boranjem u fazi postanka 

fleksure, onda su u kasnijoj evoluciji navlake zadržali približno strukturnu formu ljuske. 

Naime, na njih nisu mogli tako snažno utjecati, za paleozoik ovi već periferni eocenski 

pokreti. 

S obzirom da se iz ovako nastale navlake da rekonstruirati položaj korijena u autohtonu, 

može se pretpostaviti da pomak alohtona ne prelazi 15 km. 

Općenito, alohton ima formu sinklinale s blago boranim dnom. Izgrađuju ga trijaski, 

jurski i donjokredni sedimenti. Karakteristično je da ima drugačiji razvoj jurskih i 

donjokrednih naslaga od istih naslaga autohtona područja Mosora i Biokova, od kojih se još 

razlikuje i skoro dvostruko većom debljinom malma. Tako radikalna promjena 

sedimentacije u juri i donjoj kredi na relativno malome prostoru od Mosora do Jabuke, 

prihvatljivija je ako se današnji položaj naslaga šireg područja Jabuke, tretira kao 

neautohtoni položaj. Dakle, i ovaj moment kao i prije dano strukturno objašnjenje, ukazuju 

da se radi o najvišem stupnju tektonske deformacije – navlaci. (Marinčić i dr., 1969). 
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 POSTUPAK IZRADE MODELA TERENA POMOĆU TOPOGRAFSKIH 

PODLOGA 

Uporaba računala u suvremenom svijetu je u konstantnom porastu, pa se paralelno tome 

sve više primjenjuje i u projektiranju u rudarstvu. Kako se model računalno može prikazati 

u tri dimenzije, mnogo je lakše predočavanje problema naspram dvije dimenzije. 

Topografske karte u izvornim oblicima su u rasterskom obliku, a najčešće su to već 

postojeće karte. Za potrebe računalne obrade podataka rasterski oblik nije odgovarajući te 

se zbog toga obavlja postupak vektorizacije. Vektorizacija se obavlja prenošenjem detalja sa 

rasterskih slika na vektorske slike uz pomoć geometrijskih elemenata kao što su točke, crte 

ili poligoni. (Plećaš, 2016). 

 

Kako bi bilo moguće izraditi računalni model terena istražnih prostora, potrebno je imati 

topografsku kartu šireg područja promatranja. Karta se tada unosi u računalni program 

Power InRoads tako da odaberemo na alatnoj traci: 

File → Raster Manager → Attach 
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3.1. Izrada vektorske karte 

Sljedeći korak je vektorizacija, a ona se radi ucrtavanjem slojnica terena alatom „Place 

Point or Stream Curve“. Radi se vektorizacija glavnih i pomoćnih slojnica užeg i šireg 

područja. (Slika 3-1.) 

 

Slika 3-1. Vektorizacija topografske karte dobivene u mjerilu M1:25 000 
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3.2. Pozicioniranje elemenata u prostor 

 

Nakon slojnica, precrtaju se i ceste te se podižu po "Z" osi odnosno u 3D prostor da se 

može dobiti 3D model ležišta arhitektonsko-građevnog kamena na području Aržana. Kako 

bi ovaj postupak mogao početi potrebno je trenutnu 2D datoteku pretvoriti u 3D oblik 

pomoću naredbe: 

File → Export → 3D 

 

Nakon toga slijedi podizanje elemenata u prostor što se može napraviti na više načina. 

Ovoga puta je korištena aplikacija "ModZ" odabirom putanje: 

Utilities → MDL Applications → MODZ → Load 

te u ponuđenom polju upisujemo potrebne visine i podižemo elemente pojedinačno ili u 

skupinama (slika 3-2.).  

 

 

Slika 3-2. ModZ aplikacija 

 

3.3. Trenutno stanje terena 

Podizanjem svih slojnica na njihovu visinu dobivamo njihov prikaz u trodimenzionalnom 

okruženju. Trodimenzionalno okruženje omogućava pogled na slojnice terena iz svih kutova 

što daje puno jasniju sliku o terenu. (Plećaš, 2016). 

Nakon što se slojnice skupa sa cestama podignu u treću dimenziju dobije se situacija 

terena (slika 3-3.) 
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Slika 3-3. „Top View“ pogled na slojnice (crno) i ceste (zeleno) 3D prikazu nakon 

podizanja na njihove visine M 1: 50 000 

 

3.4. Triangulacija terena 

Triangulacija je dijeljenje površine ili ravninskog poligona u mrežu trokutova pri čemu 

je svaka stranica mreže zajednička dvjema susjednim trokutima. Takav model sačinjava niz 

trokutova formiranih na bazi referentnih točaka – bušotina. Triangulacijom se predstavljaju 

površine terena, krovine ili podine sloja, rudnog tijela, površinskog kopa i sl. (Galić i Farkaš, 

2011). 

Za početak potrebno je izraditi površinu za triangulaciju: 

Power InRoads file → new 

Nakon toga se poziva potrebna površina: 

File → Power InRoads Import → Surface 

i dobije se prozor kao na slici 3-4. 
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Slika 3-4. Postavke naredbe „Import Surface“ 

 

Naredbom „Triangulate Surface“ te klikom na „Apply“ počinje triangulacija i softver 

ispiše koliko je trokuta upotrijebio. Nakon toga se još za prikaz triangulacije koristi naredba: 

Surface → View Surface → Triangles 

odabere se željeni "level" u koji se triangulacija želi spremiti i klikne na „Apply“. 

Triangulirani  teren prikazan je na slici 3-5. u renderiranom „Smooth“ obliku, a na slici 3-6. 

u žičnom „Wireframe“ obliku. 
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Slika 3-5. Prikaz trianguliranog terena u žičnom „Wireframe“ obliku 

 

 

Slika 3-6. Prikaz trianguliranog 3D modela terena predloženog istražnog prostora 

„Aržano“ u renderiranom (smooth) obliku 
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3.5. Podizanje elemenata na površinu terena 

Sljedeći korak je podizanje elemenata na teren u skupinama (po levelima) ili pojedinačno, 

naredbom „Drape Surface“: 

Surface → Design Surface → Drape Surface 

U ovom slučaju ceste su podignute na teren kao što je prikazano na slici 3-7. 

 

 

 

Slika 3-7. Slojnice (crno) i ceste (zeleno) planiranog istražnog područja Aržano prikazane 

u 3D modelu 
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3.6. Izrada navlaka i rasjeda 

Navlake i rasjede je bilo potrebno prvo precrtati naredbom „Place Point or Stream Curve“ 

sa OGK SFRJ 1:100 000, list Omiš kako bi se dobio izgled kao na slici 3-8. 

 

Slika 3-8. Precrtani rasjedi (crveno) i navlake (narančasto) M 1: 50 000 (Marinčić i dr., 

1969). Za legendu vidi sl.2-3. 

 

Rasjedi su postavljeni pod kutom od 90°, a navlake pod kutom od 45° temeljem podataka 

iz OGK SFRJ 1:100 000, list Omiš. Povoljno je što se na prostoru nalaze srednje do debelo 

uslojeni kalcilutiti i kalkareniti te vapnenci kojima je slojevitost dobro izražena. (Marinčić i 

dr., 1969). Takve strukture su važne zbog svoje blokovitosti i višeslojnosti i na samom 

razvoju rudarskih radova jer se arhitektonsko građevni kamen vadi u blokovima. 

 Alat koji se koristio nalazi se u komandnoj traci „Drawing“ pod nazivom „Place Line“ 

te se ucrta rasjed pod kutom od 45° (slika 3-9.) 

 

 

Slika 3-9. Prozor alata „Place Line“ 
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Zbog ljepšeg prikaza linije svakog pojedinog rasjeda i navlake spojene su u zasebni 

element naredbom „Create Complex Shape“. Alat je jednostavan, kad se odabere treba samo 

lijevim klikom miša označavati što se želi spojiti u jedan element. 

Izgled rasjeda i navlaka ispod površine terena (zelena) u ispunjenom renderiranom 

„Smooth“ prikazu vidi se na slici 3-10. 

 

 

Slika 3-10. Renderirani smooth prikaz navlaka (smeđa) i rasjeda (crvena) ispod površine 

terena (prozirno zelena) 
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 MODELIRANJE ISTRAŽNIH RADOVA, GRANICA REZERVI I ZAVRŠNE 

KONTURE POVRŠINSKOG KOPA 

4.1. Kategorizacija rezervi arhitektonsko građevnog kamena 

Prema vrsti stijena, obliku pojavljivanja, veličini i oštećenosti stijenske mase, tektonskim 

pokretima, hidrotermalnim procesima i drugim utjecajima, ležišta arhitektonskoga-

građevnog kamena razvrstavaju se u četiri skupine:  

1. u prvu skupinu uvrštavaju se ležišta arhitektonsko - građevnog kamena sedimentnih 

stijena oblika slojeva ili leća. Zahvaćenost tektonskim pokretima je neznatna i bitno ne utječe 

na iskorištenje stijenske mase;  

2. u drugu skupinu uvrštavaju se ležišta arhitektonskog - građevnog kamena sedimentnih 

stijena oblika slojeva ili leća. Zahvaćenost tektonskim pokretima je znatna i bitno utječe na 

iskorištenje stijenske mase;  

3. u treću skupinu uvrštavaju se ležišta arhitektonskoga - građevnog kamena magmatskih 

i metamorfnih stijena oblika leća i drugih nepravilnih oblika. Zahvaćenost tektonskim 

pokretima je neznatna i bitno ne utječe na iskorištenje stijenske mase;  

4. u četvrtu skupinu uvrštavaju se ležišta arhitektonskog - građevnog kamena magmatskih 

i metamorfnih stijena oblika leća i drugih nepravilnih oblika. Zahvaćenost tektonskim 

pokretima je znatna i bitno utječe na iskorištenje stijenske mase. 

 

Ležišta arhitektonsko – građevnog kamena istražuju se prema odredbama članaka 52. do 

54. Pravilnika o prikupljanju podataka, načinu evidentiranja i utvrđivanja rezervi mineralnih 

sirovina te o izradi bilance tih rezervi (Ministarstvo energetike i industrije, 1992), prema 

tome za utvrđivanje i razvrstavanje rezervi kategorija A, B i C1 treba biti udovoljeno 

sljedećim uvjetima: 

1. Najveće udaljenosti između istražnih radova za pojedine skupine ležišta dane su u 

tablici 4-1.  
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Tablica 4-1. Udaljenosti istražnih radova arhitektonsko-građevnog kamena 

 Najveće udaljenosti između istražnih radova u m 

Skupina ležišta A – kategorija B – kategorija C – kategorija 

I 60 120 240 

II 50 100 200 

III 40 80 160 

IV 30 60 120 

 

2. za razvrstavanje rezervi arhitektonskoga građevnog kamena u kategoriju A i B treba 

probnom eksploatacijom utvrditi mogućnost pridobivanja komercijalnih blokova.  

 

Kakvoća arhitektonsko - građevnog kamena određuje se prema odredbama članaka 55. 

do 57. ovoga pravilnika, pri čemu za određivanje kakvoće rezervi kategorija A, B i C1, mora 

biti udovoljeno i slijedećim uvjetima:  

1. uzorci za kompletna ispitivanja fizičko mehaničkih svojstava uzimaju se najmanje na 

dva mjesta u istraživanom dijelu stijenske mase. Ako istraženi dio ležišta sadrži više od 

1,000.000 m3 stijenske mase uzimaju se tri uzorka; ako u ležištu postoje dvije ili više vrsta 

arhitektonskoga građevnog kamena, broj uzoraka povećava se prema broju vrsta;  

2. uzorci za djelomična fizičko-mehanička ispitivanja uzimaju se iz jezgre bušotina radi 

usporedbe rezultata dobivenih kompletnom analizom;  

3. fizičko mehanička svojstva ispituju se na svim uzorcima prema propisanim 

standardima i na temelju njih se daje ocjena o kakvoći i upotrebljivosti arhitektonskoga 

građevnog kamena;  

4. prilikom probne eksploatacije potrebno je, na raskrivenom dijelu ležišta, obaviti 

detaljno snimanje svih pukotina i razmaka među njima, izraditi strukturni plan u mjerilu 

1:100 i utvrditi mogućnost i količinu postojanja zdravih blokova;  

5. tehnološka ispitivanja arhitektonskoga građevnog kamena izvode se po režimu redovne 

proizvodnje, odnosno svi uzeti uzorci režu se u ploče, glačaju i oblikuju. Analizira se 

ponašanje arhitektonskoga građevnog kamena pri obradi i proračunava postotak iskorištenja 

sirovih blokova pri preradi. (Pravilnik o prikupljanju podataka, načinu evidentiranja i 

utvrđivanja rezervi mineralnih sirovina te o izradi bilance tih rezervi NN 48/92). 
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Istražne bušotine su napravljene pomoću naredbe „Place Circle“ i popunjene crvenom 

bojom radi boljeg uočavanja. Za rezerve A bušotine su locirane na udaljenosti 60 m, za 

rezerve B na 120 m i za rezerve C1 na 240 m kako je prikazano na slici 4-1. za sjeverno 

istražno polje, te na slici 4-2. za južno istražno polje. 

U tablicama 4-2. i 4-4. prikazane su koordinate i dubine bušotina uz napomenu da su se 

bušotine bušile do 700 m n.v. 

Raskopi R1 i R2 kreću od kote 760 m n.v. za kop „Aržano sjever“ i 700 m n.v. za kop 

„Aržano jug“ uz osnovni plato, a koordinate i površine se nalaze u tablicama 4-3 i 4-5. 

 

 

 

Slika 4-1. Topografska karta sa prikazom istražnih radova za istražni prostor „Aržano 

sjever“ M 1: 5 000 
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Tablica 4-2. Koordinate i duljine bušotina sjevernog istražnog prostora 

Oznaka 

bušotina 

Koordinate bušotina Duljine bušenja 

(m) Y (m) X (m) Z (m) 

B1 536383 536383 114 110,0 

B2 4829074 536610 46 108,7 

B3 4829382 536461 388 80,8 

B4 4829343 536575 355 74,4 

B5 4829303 536688 321 75,5 

B6 4829493 536500 642 67,3 

B7 4829474 536557 175 65,7 

B8 4829454 536613 308 63,6 

B9 4829434 536670 442 63,6 

B10 4829415 536727 576 62,5 

    Σ = 772,1 

 

 

Tablica 4-3. Koordinate i površina raskopa sjevernog istražnog prostora 

Oznaka raskopa Y (m) X (m) Z (m) Površina (m2) 

R1 4829540 536516 149 342,9 

R2 4829438 536735 294 286,7 
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Slika 4-2. Topografska karta sa prikazom istražnih radova za istražni prostor „Aržano jug“ 

M 1: 5 000 
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Tablica 4-4. Koordinate i duljine bušotina južnog istražnog prostora 

Oznaka 

bušotina 

Koordinate bušotina Duljine bušenja 

(m) Y (m) X (m) Z (m) 

B1 4827862 537136 849 94,2 

B2 4827986 537342 655 67,0 

B3 4827656 537260 561 46,8 

B4 4827718 537363 965 39,9 

B5 4827780 537466 368 38,6 

B6 4827553 537322 417 18,8 

B7 4827584 537374 119 21,1 

B8 4827615 537425 821 20,9 

B9 4827646 537477 523 14,4 

B10 4827677 537528 225 5,7 

    Σ = 367,4 

 

 

Tablica 4-5. Koordinate i površina raskopa južnog istražnog prostora 

Oznaka raskopa Y (m) X (m) Z (m) Površina (m2) 

R1 4827520 537343 252 366,3 

R2 4827647 537546 411 472,2 

 

Za izradu modela u 3D potrebno je sve rezerve podići na visinu osnovnog platoa 

naredbom 

Surface → Design Surface → Set elevation (slika 4-3.) 
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Slika 4-3. Naredba „Set Elevation“ 

 

Za sjeverni kop osnovni plato nalazi se na 760 m n.v., a za južni kop nalazi se na 700 m n.v. 

i to su nam sada donje granice rezervi. Kako bi dobili gornje granice moramo ih podići na 

visinu terena naredbom 

Surface → Design Surface → Drape Surface 

 

Podizanjem granica u 3D prostor dobije se prikaz rezervi za sjeverni i južni kop (slika 4-4. i 

4-5.) 
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Slika 4-4. Prikaz rezervi kopa „Aržano sjever“ M 1:5 000 

 

 

Slika 4-5. Prikaz rezervi kopa „Aržano jug“ M 1:5 000 
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4.2. Modeliranje završne konture površinskog kopa 

Potrebni parametri za izradu etaža su: broj etaža, visina etaže, širina etažne ravnine 

(berma) i nagibi etažne, radne i završne kosine. 

Kod ležišta arhitektonsko-građevnog kamena nagib etažnih kosina je oko 90o, a 

najpovoljnija visina je 6 – 10 m ovisno o uvjetima ležišta, tehnološkim zahtjevima 

eksploatacije i tržišta. 

Na kamenolomima arhitektonsko-građevnog kamena cilj je dobiti zdravi blok, pa je 

svrhovito primijeniti način otkopavanja koji u najmanjoj mogućoj mjeri izaziva naprezanja 

i deformacije u stijenskoj masi. Zato se na tim kamenolomima primjenjuju metode dobivanja 

blokova, bez uporabe eksplozivnih sredstava, tj. uporabi eksploziva samo pri skidanju 

otkrivke na mjestima gdje je otkrivka izrazito debela. Nastanak naprezanja i deformacija 

isključuje žična pila, pa je kamenolomima arhitektonsko-građevnog kamena najprihvatljiviji 

način dobivanja blokova različitim metodama piljenja, njihovim prevrtanjem na etažni plato, 

te oblikovanjem u komercijalne blokove. (Dunda i dr., 2001). 

 

Potrebno je odrediti najveću visinsku razliku na kopu (razlika između najviše točke te 

osnovne razine) pomoću naredbe: „Measure Distance“. Za sjeverni kop razlika iznosi 50 m, 

a za južni 94 m. 

Predloženi projektni parametri za buduće površinske kopove "Aržano sjever" i "Aržano 

jug" su: berma će iznositi 3 m, visina etaže 6 m, kut nagiba etažne kosine približno 90° a kut 

nagiba završne kosine je oko 60°. 

 Kako bi se izračunao broj etaža, visinsku razliku potrebno je podijeliti sa visinom etaže: 

 𝑛𝑠 =
𝐻𝑘

ℎ𝑒
=

50

6
= 8,33 usvojeno 9 etaža (4-1) 

 𝑛𝑗 =
𝐻𝑘

ℎ𝑒
=

94

6
= 15,66 usvojeno 16 etaža (4-2) 

ns – broj etaža sjevernog kopa 

nj – broj etaža južnog kopa 

Hk – maksimalna visinska razlika kopa, m 

he – visina etaže, m 
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Za obje krajnje etaže zaokruženo je na veći broj jer prelaze 30% maksimalne visine etaže, 

i te zadnje etaže će biti nešto kraće od 6 m. 

 

4.3. Izrada 2D prikaza završnih kontura površinskog kopa 

Etaže se crtaju u 2D, osnovni plato je na 760 m n.v. na sjevernom, a na južnom kopu 700 

m n.v. Iz razloga što postoje linije granica rezervi otprije, one mogu pomoći u 

konstruiranju etaža. Naredbom „Copy/Move Parallel“ se precrtaju vanjske granice (C1 

rezerve) u razmaku širine etaže od 3 m prema unutrašnjosti kopa. Postupak se ponovi u 

ovisnosti koliko etaža trebamo nacrtati. Sada se uređuju pozicije gdje širina etaže izlazi na 

teren. Berma mora izaći na slojnicu iste nadmorske visine na kojoj se i sama nalazi. Na 

primjer, osnovni plato sjevernog kopa je na 760 m n.v., visina etaže je 6 m te prva berma 

mora izaći na slojnicu na 766 m n.v., iduća na 772 m n.v. i tako dalje. Linije širine etaže se 

skraćuju sa linijama slojnica naredbom „Trim To Element“, a nakon toga se etaže spajaju 

sa krivuljama koje će pratiti slojnicu naredbom „Place Point or Stream Curve“. 

4.4. Izrada 3D modela površinskog kopa 

Trenutnu datoteku potrebno je prebaciti u 3D način rada i to naredbom: 

File → Export → 3D 

Nakon toga se otvori nova 3D datoteka te se sve slojnice i etaže  moraju postaviti na 

pripadajuću nadmorsku visinu. U prethodnom poglavlju je korištena naredba „ModZ“, a 

ovoga puta je korištena naredba „Set Elevation“ da bi se pokazalo kako je moguće podizati 

elemente na više načina. Na postojeći teren je potrebno dići i gornje krajeve etaža sa 

naredbom „Drape Surface“ kako bi pratile izgled terena. U izborniku naredbe postavi se 

površina gdje hoćemo podići zadane linije, u ovom slučaju to je „Teren!“ te kliknemo na 

naredbu „Apply“. 
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Na sljedećim slikama dan je prikaz sjevernog (slika 4-7.) i južnog predloženog 

površinskog kopa (slika 4-8.) 

 

 

Slika 4-6. Prikaz geometrizacije završnih kontura na predloženom kopu „Aržano sjever“ 
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Slika 4-7. Prikaz geometrizacije završnih kontura na predloženom kopu „Aržano jug“ 
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4.5. Triangulacija etaža 

Kako se radi o kamenolomu arhitektonsko građevnog kamena, u softveru Power Inroads 

nailazimo na problem zbog kuta između etaža od 90° pa projekcija gornjeg i donjeg ruba 

etaže u tlocrtu čini jednu crtu. Stoga se crta koja graniči sa dvije etaže mora kopirati i podići 

za visinu etaže, što u ovom slučaju iznosi 6 m. 

Prije kopiranja treba ukazati na tehničku nemogućnost računalnog programa Power 

InRoads, u kojem se izvodi obrada i triangulacija 3D modela, da napravi inicijalnu 

triangulaciju 3D modela i plohe koje su nagnute pod 90° ili više. U tom slučaju događa se 

pogrešna obrada podataka i nepostojeće plohe jer računalni program ne može interpretirati 

plohe između kojih je kut 90° jer je vrijednost tangensa kuta tada beskonačna vrijednost. 

Rješenje je da se napravi minimalni otklon (horizontalna projekcija) od par milimetara do 

par centimetara koji dozvoljava softveru da napravi proračun, a takva udaljenost neće 

utjecati uvelike na proračune a niti na geometriju kopa. (Plećaš, 2016). 

Sada se izaberu etaže dignute u 3D i napravi nova datoteka. Tako se stvara nova površina 

(etaže i osnovni plato) prije triangulacije. Nakon toga se poziva potrebna površina: 

File → Power InRoads Import → Surface 

Naredbom „Triangulate Surface“ te klikom na „Apply“ počinje triangulacija i softver 

ispiše koliko je trokuta upotrijebio. Nakon toga se još za prikaz triangulacije koristi naredba: 

Surface → View Surface → Triangles 

Odabire se level u koji se triangulacija želi spremiti i klikne na „Apply“. Triangulirane 

etaže su prikazane za sjeverni (slika 4-9. i 4-10.) i južni kop (slika 4-11. i 4-12.) 
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Slika 4-8. Triangulirani model konture površinskog kopa „Aržano sjever“ u žičnom 

(wireframe) prikazu 

 

  

Slika 4-9. Triangulirani model konture površinskog kopa „Aržano sjever“ u ispunjenom 

renderiranom (smooth) prikazu 
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Slika 4-10. Triangulirani model konture površinskog kopa „Aržano jug“ u žičnom 

(wireframe) prikazu 

 

Slika 4-11. Triangulirani model konture površinskog kopa „Aržano jug“ u ispunjenom 

renderiranom (smooth) prikazu 
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 PRORAČUN REZERVI 

S obzirom na klasu rezerve mineralne sirovine  mogu biti bilančne ili izvanbilančne. 

Bilančne rezerve definiramo kao one koje su u određenom trenutku postojećom tehnikom i 

tehnologijom eksploatacije i prerade mogu rentabilno koristiti, dok su izvanbilančne rezerve 

one rezerve koje se u određenom trenutku postojećom tehnikom i tehnologijom eksploatacije 

i prerade ne mogu rentabilno koristiti (najčešće rezerve u završnim kosinama kopa i 

zaštitnim stupovima). Klasifikacija rezervi je tako promjenjiva kroz godine, zbog činjenice 

što napretkom tehnologije isplativost eksploatacije raste pa određene rezerve iz stupnja 

izvanbilančnih mogu preći u bilančne rezerve. Klasifikacija rezervi utvrđuje se tehničko 

ekonomskom ocjenom gdje su analizom obuhvaćeni parametri: geološki, genetski, tehničko-

eksploatacijski, tehnološki, regionalni, tržišni i društveno gospodarski.  

Kontura završnog stanja predstavlja ustvari granicu bilančnih i izvanbilančnih 

rezervi te se pretpostavlja da su sve količine iznad razine završnog stanja osnova za proračun 

bilančnih i eksploatacijskih rezervi. Isto tako, sve količine ispod završne konture (kosine) 

predstavljaju osnovu za proračun izvanbilančnih rezervi. (Plećaš, 2016). 

5.1. Proračun obujma očekivanih rezervi metodom računalnog modeliranja 

Proračun rezervi arhitektonsko-građevnog kamena obavljen je primjenom dvije metode 

(metoda računalnog modeliranja i metoda pomoću paralelnih presjeka). 

Metoda računalnog modeliranja računa integral između trokuta-najmanjih dijelova plohe. 

Za svaki trokut računa se volumen do njemu nasuprotnog trokuta tj. računa se volumen koji 

zatvaraju nasuprotni trokuti. Zbrajanjem ili oduzimanjem vrijednosti pojedinih volumena 

dobije se ukupan volumen između pojedinih ploha. (Galić i Farkaš, 2011). 

Prvi korak je učitavanje napravljenih generiranih datoteka u .dtm formatu prema kojima 

se radi proračun rezervi: 

Applications → InRoads Group → File → Open 

 

te se odaberu ukupne rezerve (bilančne i izvanbilančne) i situacija terena 

Nakon toga slijedi naredba „Triangle Volume“ (slika 5-1.) 
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Slika 5-1. Naredba „Triangulate Volume“ za izračun obujma 

 

„Teren“ predstavlja trenutnu situaciju terena od koje se radi izračun obujma ukupnih rezervi. 

„A_sjever“ predstavlja ukupne rezerve kopa „Aržano sjever“ za A kategoriju. 

„B_sjever“ predstavlja ukupne rezerve kopa „Aržano sjever“ za B kategoriju. 

„C1_sjever“ predstavlja ukupne rezerve kopa „Aržano sjever“ za C1 kategoriju. 

Slijedi lijevi klik na „Apply“ i dobije se rezultat proračuna ukupnih rezervi, a identičan 

slijed radnji je potreban i za kop „Aržano jug“. 

Prikaz izračuna nalazi se na slikama 5-2. i 5-3. 
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Slika 5-2. Ukupni obujam stijenske mase u predloženom kopu „Aržano sjever“ 
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Slika 5-3. Ukupni obujam stijenske mase u predloženom kopu „Aržano jug“ 



 

39 

 

Kada se zbroje  ukupni obujam rezervi sa slike 5-2. i ukupni obujam sa slike 5-3. dobije 

se ukupni obujam bilančnih i izvanbilančnih rezervi arhitektonsko-građevnog kamena za 

predloženi sjeverni i južni površinski kop. (tablica 5-1) 

 

Tablica 5-1. Obujam očekivanih rezervi metodom računalnog modeliranja 

  Ukupne količine bilančnih i izvanbilančnih rezervi 

m3 

„Aržano sjever“ 2 565 727 

„Aržano jug“ 4 421 212 
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5.2. Proračun obujma očekivanih rezervi metodom paralelnih presjeka 

 

U prvom slučaju rezerve su utvrđivane metodom računalnog modeliranja, a u drugom je 

korištena metoda pomoću paralelnih presjeka. 

Ova metoda može se raditi na dva načina: manualno (ručno) ili računalno. Za ovo ležište 

primijenjena je manualna metoda. Ova metoda se temelji na postavljanju niza presjeka duž 

ležišta. Važno je postaviti presjeke kroz karakteristične točke u kojima dolazi do  promjene 

terena, sastava mineralne sirovine te na granicama rezervi različitih kategorija. 

 

Metoda paralelnih vertikalnih presjeka teoretski gledano zasniva se na računanju 

površina svakog presjeka pojedinačno. Zatim se računa aritmetička sredina površina 

presjeka između susjednih presjeka po formuli: 

𝑃𝑠𝑟 =
𝑃𝑛 + 𝑃𝑛+1

2
(5 − 1) 

Psr – srednja površina, m2 

Pn – površina n-tog vertikalnog presjeka 

Pn+1 – površina n+1 vertikalnog presjeka 

 

Kada se susjedne površine razlikuju za više od 40% onda se srednja površina računa 

prema izrazu: 

𝑃𝑠𝑟 =  
𝑃𝑛 + 𝑃𝑛+1 +  √𝑃𝑛 ∗ 𝑃𝑛+1

3
(5 − 2) 
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Za izračunavanje obujma, aritmetička sredina površine dvaju presjeka se množi sa 

udaljenosti između dva postavljena presjeka.  

𝑂𝑛..𝑛+1 =  𝑃𝑠𝑟∗ 𝑙𝑛..𝑛+1
(5 − 3) 

O – obujam, m3 

l – udaljenost između dva presjeka, m 

Takav postupak se ponavlja za sve susjedne presjeke i u konačnici se svi dobiveni obujmi 

zbrajaju prema izrazu (Galić i Farkaš, 2011). 

𝑂 =  ∑ 𝑂𝑖

𝑟

𝑖=1

(5 − 4) 

i – broj bloka 

r – ukupni broj blokova (broj presjeka) 

 

Za izradu presjeka potrebno je ponovo otvoriti datoteku u 2D te u nju umetnuti datoteku 

koja je u 3D naredbom: 

File → References → Tools → Attach 

odabere se željena 3D datoteka i nakon potvrde otvara se izbornik koji izgleda kao na 

slici 5-4. 
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Slika 5-4. Izbornik postavki za umetanje reference u softver 

 

Otvori se novi „level“ pod nazivom „presjeci“ te se naredbom „Place Line“ ucrtavaju 

presijeci. Prvi presjek postavlja se paralelno sa A rezervama, a duljina presjeka treba biti 

cijeli broj zaokružen na deseticu te da prelazi preko rubova kopa. Broj presjeka ovisi o 

karakterističnim mjestima kao na primjer mjesto gdje se sijeku granice rezervi. 

 

Za predloženo eksploatacijsko polje „Aržano sjever“ sve površine rezervi će se unositi 

od dubine otkopavanja (osnovne slojnice) koja iznosi 760 m n.v., a za predloženo 

eksploatacijsko polje „Aržano jug“ će se unositi od dubine od 700 m n.v. 
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Potrebno je odrediti i azimut presjeka (otklon od sjevera) naredbom „Dimension 

Angular“. Za predloženi kop „Aržano sjever“ izmjereni azimut iznosi 20° a za predloženi 

kop „Aržano jug“ izmjereno je 30°. 

Granice bilančnih i izvanbilančnih rezervi su omeđene presjecima 2-2' i 6-6', s unutarnje 

strane se nalaze bilančne a sa vanjske izvanbilančne rezerve. Primjeri ucrtanih presjeka 

prikazan je na slici 5-5 i 5-6. 

 

 

Slika 5-5. Primjer postavljenih presjeka na predloženom kopu „Aržano sjever“ M 1:5 000 
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Slika 5-6. Primjer postavljenih presjeka na predloženom kopu „Aržano jug“ M 1:5 000 

 

Nakon toga trebaju se učitati prethodno izrađene površine od slojnica terena i od etaža 

naredbom: 

File → Power InRoads file → Open 

Presjeci se kreiraju naredbom: 

Evaluation → Profile → Create Profile 

gdje se u izborniku moraju postaviti razne postavke kao što su: prikaz apscise i ordinate u 

mjerilu, postavke lijeve i desne osi presjeka, simbologija teksta, postavke mreže i naslova 

presjeka i odabir metode za kreiranje presjeka (slika 5-7.). 
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Slika 5-7. Odabir metode za kreiranje presjeka 

 

Nakon što su postavke odabrane pritisne se „Apply“, te lijevim klikom miša odaberemo 

željeni presjek i na koncu dva puta klik lijevog miša gdje želimo iscrtati presjek. 

 

Iscrtavanje rezervi na profile obavlja se tako da učitavamo početak rezervi na presjeku u 

tlocrtu pa sve do njihovog završetka. (Soldo i Šetka, 2016). 

Presjeci se naknadno zbog vizualnog prikaza mogu urediti bojama, izmjeri se površina 

naredbom „Measure Area“ te se dobivena površina unese kao što je prikazano na slikama od 

5-8. do 5-21. 
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Slika 5-8. Presjek 1-1' kopa „Aržano sjever“ 

 

 

 

Slika 5-9. Presjek 2-2' kopa „Aržano sjever“  
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Slika 5-10. Presjek 3-3' kopa „Aržano sjever“ 

 

 

Slika 5-11. Presjek 4-4' kopa „Aržano sjever“ 
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Slika 5-12. Presjek 5-5' kopa „Aržano sjever“ 

 

 

 

Slika 5-13. Presjek 6-6' kopa „Aržano sjever“ 
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Slika 5-14. Presjek 7-7' kopa „Aržano sjever“ 
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Slika 5-15. Presjek 1-1' kopa „Aržano jug“ 

 

Slika 5-16. Presjek 2-2' kopa „Aržano jug“ 
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Slika 5-17. Presjek 3-3' kopa „Aržano jug“ 

 

Slika 5-18. Presjek 4-4' kopa „Aržano jug“ 
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Slika 5-19. Presjek 5-5' kopa „Aržano jug“ 

 

Slika 5-20. Presjek 6-6' kopa „Aržano jug“ 
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Slika 5-21. Presjek 7-7' kopa „Aržano jug“ 
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U tablici 5-2. nalazi se tumač oznaka sa presjeka. 

 

Tablica 5-2. Tumač oznaka rezervi 

Oznaka Značenje 

A bil. Bilančne A rezerve 

B bil. Bilančne B rezerve 

C bil. Bilančne C1 rezerve 

A izv.bil. Izvanbilančne A rezerve 

B izv.bil. Izvanbilančne B rezerve 

C1 izv.bil. Izvanbilančne C1 rezerve 

Et. etaža 

 C1 rezerve 

 B rezerve 

 A rezerve 

 Linija površine terena 

 Etaže 

 
Bušotina 

 

Proračuni obujma bilančnih i izvanbilančnih rezervi predloženih kopova „Aržano sjever“ 

i „Aržano jug“ su prikazani u tablicama od 5-3. do 5-6. 
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Tablica 5-3. Proračun obujma bilančnih rezervi za predloženi kop „Aržano sjever“ 

PRORAČUN BILANČNIH REZERVI - ARŽANO SJEVER 
             

Presjek 
A 

kategorija 
      

B 
kategorija 

      
C1 

kategorija 
      

  
   

POVRŠINA, 
m2 

  
Udaljenost 

presjeka 
Obujam 

   
POVRŠINA, 

m2 
  

Udaljenost 
presjeka 

Obujam 
   

POVRŠINA, 
m2 

  
Udaljenost 

presjeka 
Obujam 

  P pres. Psr   O=Psr * l P pres. Psr   Ob=Psr * l P pres. Psr   Ob=Psr * l 

      l,  m m3      l,  m m3  č.m.     l,  m m3  č.m. 

1-1' 0,00 34,41 29,0 997,99 0,00 488,60 29,0 14.169,4 0,00 3.330,54 29,0 96.585,56 

2-2' 103,24       1.465,80       9.991,61       

2-2' 103,24 114,39 37,0 4.232,52 1.465,80 1.449,64 37,0 53.636,7 9.991,61 10.223,10 37,0 378.254,69 

3-3' 125,92       1.433,54       10.456,35       

3-3' 125,92 123,16 60,0 7.389,59 1.433,54 1.448,41 60,0 86.904,6 10.456,35 10.773,69 60,0 646.421,49 

4-4' 120,42       1.463,33       11.094,18       

4-4' 120,42 245,85 60,0 14.750,93 1.463,33 1.564,87 60,0 93.892,0 11.094,18 11.187,86 60,0 671.271,83 

5-5' 398,16       1.668,65       11.281,81       

5-5' 398,16 333,82 29,0 9.680,65 1.668,65 1.890,05 29,0 54.811,6 11.281,81 11.262,87 29,0 326.623,37 

6-6' 273,37       2.120,47       11.243,95       

6-6' 273,37 91,12 37,0 3.371,56 2.120,47 706,82 37,0 26.152,5 12.243,95 4.081,32 37,0 151.008,72 

7-7' 0,00       0,00       0,00       

UKUPNO       27.371,03       248.602,7       1.792.533,57 
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Tablica 5-4. Proračun obujma bilančnih rezervi za predloženi kop „Aržano sjever“ 

PRORAČUN IZVANBILANČNIH REZERVI - ARŽANO SJEVER 

             

Presjek 

A kategorija B kategorija C1 kategorija 

   POVRŠINA, 
m2 Udaljenost 

presjeka 

Obujam    POVRŠINA, m2 Udaljenost 
presjeka 

Obujam    POVRŠINA, m2 Udaljenost 
presjeka 

Obujam 

P pres. Psr 
Ob=Psr * l 

P pres. Psr 
Ob=Psr * l 

P pres. Psr 
Ob=Psr * l 

l,  m m3  č.m. l,  m m3  č.m. l,  m m3  č.m. 

1-1' 55,61 
18,54 29,0 537,56 

1.275,60 
425,20 29,0 12.330,8 

10.323,10 
5.031,47 29,0 145.912,60 

2-2' 0,00 0,00 1.221,01 

2-2' 0,00 
0,00 37,0 0,00 

0,00 
0,00 37,0 0,0 

1.221,01 
1.216,93 37,0 45.026,33 

3-3' 0,00 0,00 1.212,85 

3-3' 0,00 
0,00 60,0 0,00 

0,00 
0,00 60,0 0,0 

1.212,85 
1.212,84 60,0 72.770,70 

4-4' 0,00 0,00 1.212,84 

4-4' 0,00 
0,00 60,0 0,00 

0,00 
0,00 60,0 0,0 

1.212,84 
1.212,84 60,0 72.770,70 

5-5' 0,00 0,00 1.212,85 

5-5' 0,00 
0,00 29,0 0,00 

0,00 
0,00 29,0 0,0 

1.212,85 
1.219,51 29,0 35.365,76 

6-6' 0,00 0,00 1.226,18 

6-6' 0,00 
99,71 

37,0 
3.689,39 

0,00 
664,76 

37,0 
24.596,0 

1.226,18 
5.921,05 

37,0 
219.078,81 

7-7' 299,14   1.994,27   12.605,48   

UKUPNO       537,56       12.330,8       336.480,33 
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 Tablica 5-5. Proračun obujma bilančnih rezervi za predloženi kop „Aržano jug“ 

PRORAČUN BILANČNIH REZERVI - ARŽANO JUG 
             

Presjek 

A kategorija B kategorija C1 kategorija 

   POVRŠINA, m2 Udaljenost 
presjeka 

Obujam    POVRŠINA, m2 Udaljenost 
presjeka 

Obujam    POVRŠINA, m2 Udaljenost 
presjeka 

Obujam 

P pres. Psr 
Ob=Psr * l 

P pres. Psr 
Ob=Psr * l 

P pres. Psr 
Ob=Psr * l 

l,  m m3  č.m. l,  m m3  č.m. l,  m m3  č.m. 

1-1' 0,00 
591,83 46,0 27.224,33 

0,00 
1.826,49 46,0 84.018,39 

0,00 
5.131,67 46,0 236.056,67 

2-2' 1.775,50 5.479,46 15.395,00 

2-2' 1.775,50 
1.764,17 14,0 24.698,42 

5.479,46 
5.452,42 14,0 76.333,92 

15.395,00 
15.293,04 14,0 214.102,59 

3-3' 1.752,87 5.425,43 15.191,31 

3-3' 1.752,87 
1.752,59 60,0 105.155,70 

5.425,43 
5.284,56 60,0 317.073,58 

15.191,31 
14.725,34 60,0 883.520,27 

4-4' 1.752,32 5.144,93 14.264,23 

4-4' 1.752,32 
1.534,65 60,0 92.078,79 

5.144,93 
4.725,43 60,0 283.525,59 

14.264,23 
13.354,20 60,0 801.252,23 

5-5' 1.326,82 4.317,99 12.464,40 

5-5' 1.326,82 
1.219,46 14,0 17.072,42 

4.317,99 
4.250,71 14,0 59.509,99 

12.464,40 
12.207,78 14,0 170.908,95 

6-6' 1.115,16 4.183,79 11.952,95 

6-6' 1.115,16 
371,72 46,0 17.099,12 

4.183,79 
1.394,60 46,0 64.151,45 

11.952,95 
13.331,77 46,0 613.261,32 

7-7' 0,00 0,00 14.759,88 

UKUPNO       249.157,24       760.951,47       2.134.931,76 
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Tablica 5-6. Proračun obujma izvanbilančnih rezervi za predloženi kop „Aržano jug“ 

PRORAČUN IZVANBILANČNIH REZERVI - ARŽANO JUG 

             

Presjek 

A kategorija B kategorija C1 kategorija 

   POVRŠINA, m2 Udaljenost 
presjeka 

Obujam    POVRŠINA, m2 Udaljenost 
presjeka 

Obujam    POVRŠINA, m2 Udaljenost 
presjeka 

Obujam 

P pres. Psr 
Ob=Psr * l 

P pres. Psr 
Ob=Psr * l 

P pres. Psr 
Ob=Psr * l 

l,  m m3  č.m. l,  m m3  č.m. l,  m m3  č.m. 

1-1' 634,43 
211,48 46,0 9.727,93 

4.780,04 
1.593,35 46,0 73.293,95 

17.984,50 
9.895,12 46,0 455.175,42 

2-2' 0,00 0,00 3.625,75 

2-2' 0,00 
0,00 14,0 0,00 

0,00 
0,00 14,0 0,00 

3.625,75 
3.621,77 14,0 50.704,77 

3-3' 0,00 0,00 3.617,79 

3-3' 0,00 
0,00 60,0 0,00 

0,00 
0,00 60,0 0,00 

3.617,79 
3.469,04 60,0 208.142,50 

4-4' 0,00 0,00 3.322,39 

4-4' 0,00 
0,00 60,0 0,00 

0,00 
0,00 60,0 0,00 

3.322,39 
3.207,97 60,0 192.478,37 

5-5' 0,00 0,00 3.094,90 

5-5' 0,00 
0,00 14,0 0,00 

0,00 
0,00 14,0 0,00 

3.094,90 
3.078,39 14,0 43.097,39 

6-6' 0,00 0,00 3.061,90 

6-6' 0,00 
73,87 46,0 3.398,17 

0,00 
1.205,33 46,0 55.445,03 

3.061,90 
7.770,88 46,0 357.460,61 

7-7' 221,62 3.615,98 13.759,88 

UKUPNO       9.727,93       73.293,95       906.501,06 
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Simulirani iznosi bilančnih i izvanbilančnih rezervi prikazani su u tablicama od 5-7. do 5-

10. 

Tablica 5-7. Proračun obujma bilančnih i eksploatacijskih rezervi mineralne sirovine za 

predloženi kop „Aržano sjever“ 

Kategorija rezervi 
Ukupne količine za 

bilančne rezerve, m3 

A  27 371  

B  248 603 

C1 1 792 534 

Ukupno 2 068 508  

 

 

Tablica 5-8. Proračun obujma izvanbilančnih rezervi za predloženi kop „Aržano sjever“ 

Kategorija 

rezervi 

Ukupne količine za 

izvanbilančne rezerve, m3 

A  538  

B  12 331  

C1  336 480  

Ukupno   349 349  
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Tablica 5-9. Proračun obujma bilančnih i eksploatacijskih rezervi mineralne sirovine za 

predloženi kop „Aržano jug“ 

Kategorija rezervi 
Ukupne količine za 

bilančne rezerve, m3 

A  249 157   

B  760 951   

C1 2 134 932  

Ukupno 3 145 040 

 

 

Tablica 5-10. Proračun obujma izvanbilančnih rezervi za predloženi kop „Aržano jug“ 

Kategorija rezervi 
Ukupne količine za izvanbilančne 

rezerve, m3 

A  9 728  

B  73 294  

C1 906 501 

Ukupno 989 523  

 

Kada se zbroje ukupne količine za bilančne rezerve iz tablica 5-7. i 5-9. te ukupne količine 

za izvanbilančne rezerve iz tablica 5-8. i 5-10. dobije se ukupni obujam bilančnih i 

izvanbilančnih rezervi arhitektonsko-građevnog kamena za sjeverni i južni kop. (tablica 5-

11.) 

 

Tablica 5-11. Obujam rezervi arhitektonsko-građevnog kamena dobivenih metodom 

paralelnih presjeka 

 Ukupne količine bilančnih i izvanbilančnih rezervi 

m3 

„Aržano sjever“ 2 417 857 

„Aržano jug“ 4 134 563 
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 ZAKLJUČAK 

U ovom radu napravljen je i opisan postupak izrade trodimenzionalnog modela 

arhitektonsko-građevnog kamena i očekivanih rezervi na području Aržano. 

Proračuni obujma metode paralelnih presjeka i metode računalnog modeliranja dobiveni 

su rezultati koji se razlikuju oko 6%. Razlika je neizbježna i nastala je zbog nepravilnosti 

iscrtavanja 3D karte u programu, razlika prilikom konstruiranja i triangulacije rezervi, zbog 

gustoće postavljenih presjeka itd., ali obje metode su korištene iz razloga da jednom 

metodom možemo okvirno provjeriti drugu i obratno. 

Ukupni proračunati obujam bilančnih i eksploatacijskih rezervi arhitektonsko-građevnog 

kamena nakon što je umanjen popravnim koeficijentom za dalmatinske kamenolome (i 

dinaride) iznosi oko 425 000 m3 za predloženi sjeverni i južni površinski kop što predstavlja 

pozitivan gospodarski pokazatelj. 

  



 

62 

 

 

 LITERATURA 

 

Galić I., Farkaš B. 2011. Primijenjeni računalni programi. Skripta. Zagreb: Rudarsko-

geološko-naftni fakultet. 

Dunda S., Kujundžić T., Globan M., Matošin V. 2001. Eksploatacija arhitektonsko-

građevnog kamena. Udžbenik. Zagreb: Rudarsko-geološko-naftni fakultet. 

Marinčić S., Korolija B., Majcen Ž. 1969. Osnovna geološka karta, list Omiš. Zagreb: 

Institut za geološka istraživanja 

 

NARODNE NOVINE br. 48/92. Pravilnik o prikupljanju podataka, načinu evidentiranja i 

utvrđivanja rezervi mineralnih sirovina te o izradi bilance tih rezervi. Zagreb: Narodne 

novine d.d. 

 

Plećaš S., 2016. Modeliranje istražnih radova i površinskog kopa na ležištu arhitektonsko-

građevnog kamena „Veliki Pomet“. Diplomski rad. Zagreb: Rudarsko-geološko-naftni 

fakultet. 

 

Soldo I.,  Šetka I. 2016. Projektiranje u rudarstvu. Skripta. Zageb: Rudarsko-geološko-

naftni fakultet.  



 

63 

 

 Prilog 1 Predložak omota za CD 

  

 

Sveučilište u Zagrebu 

RUDARSKO 

GEOLOŠKO 

NAFTNI FAKULTET 

MODELIRANJE LEŽIŠTA ARHITEKTONSKO-

GRAĐEVNOG KAMENA U PODRUČJU ARŽANO 

 

Pristupnik: Ivan Pištelek, R-177 
Mentor: Prof.dr.sc. Ivo Galić 

Datum: 20.07.2018. 

2 

1 1 

3 


